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Overview

Feather is the new development board from Adafruit, and like its namesake it is thin, light, and lets you fly!
We designed Feather to be a new standard for portable microcontroller cores.

This is the Adafruit Feather 32u4 Radio (RFM69HCW) - our take on an microcontroller packet radio
transceiver with built in USB and battery charging. Its an Adafruit Feather 32u4 with a 433 or 868/915 MHz
radio module cooked in! Great for making wireless networks that can go further than 2.4GHz 802.15.4 and
similar, are more flexible than Bluetooth LE and without the high power requirements of WiFi. We have
other boards in the Feather family, check'em out here (https://adafru.it/I7B)
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At the Feather 32u4's heart is at ATmega32u4 clocked at 8 MHz and at 3.3V logic, a chip setup we've had
tons of experience with as it's the same as the Flora (https://adafru.it/dVI). This chip has 32K of flash and 2K
of RAM, with built in USB so not only does it have a USB-to-Serial program & debug capability built in with
no need for an FTDI-like chip, it can also act like a mouse, keyboard, USB MIDI device, etc.

To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium polymer
batteries and built in battery charging. You don't need a battery, it will run just fine straight from the micro
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USB connector. But, if you do have a battery, you can take it on the go, then plug in the USB to recharge.
The Feather will automatically switch over to USB power when its available. We also tied the battery thru a
divider to an analog pin, so you can measure and monitor the battery voltage to detect when you need a

recharge.

Here's some handy specs! Like all Feather 32ué's you get:

Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in
Light as a (large?) feather - 5.5 grams

ATmega32u4 @ 8MHz with 3.3V logic/power

3.3V regulator with 500mA peak current output

USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins

Hardware Serial, hardware 12C, hardware SPI support

7 x PWM pins

10 x analog inputs

Built in 100mA lipoly charger with charging status indicator LED

Pin #13 red LED for general purpose blinking

Power/enable pin

4 mounting holes

Reset button

The Feather 32u4 Radio uses the extra space left over to add an RFMG69HCW 433 or 868/915 MHz radio
module. These radios are not good for transmitting audio or video, but they do work quite well for small
data packet transmission when you ned more range than 2.4 GHz (BT, BLE, WiFi, ZigBee)
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® SX1231based module with SPI interface

® Packet radio with ready-to-go Arduino libraries

® Uses the amateur or license-free ISM bands (https://adafru.it/mOE): 433MHz is ITU "Europe" license-
free ISM or ITU "American" amateur with limitations. 900MHz is license-free ISM for ITU "Americas"
+13 to +20 dBm up to 100 mW Power Output Capability (power output selectable in software)
Create multipoint networks with individual node addresses

Encrypted packet engine with AES-128

Simple wire antenna or spot for uFL connector
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Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the Arduino IDE.
We also toss in some header so you can solder it in and plug into a solderless breadboard. You will need
to cut and solder on a small piece of wire (any solid or stranded core is fine) in order to create your
antenna. Lipoly battery and USB cable not included but we do have lots of options in the shop if you'd
like!
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The Feather 32u4 Radio is chock-full of microcontroller goodness. There's also a lot of pins and ports. We'll
take you a tour of them now!

Note that the pinouts are identical for both the Feather 32u4 RFM69 and LoRa radios - you can look at the
silkscreen of the Feather to see it says "RFM69" or "LoRa"

Pinouts are also the same for both 433MHz and 900Mhz. You can tell the difference by looking for a
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colored dot on the chip or crystal of the radio, green/blue is 900MHz & red is 433MHz
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GND - this is the common ground for all power and logic

BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery

USB - this is the positive voltage to/from the micro USB jack if connected

EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the 3.3V
regulator

® 3V - this is the output from the 3.3V regulator, it can supply 500mA peak

Logic pins
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This is the general purpose I/0 pin set for the microcontroller. All logic is 3.3V

® #0/RX-GPIO #0, also receive (input) pin for Seriall and Interrupt #2
® #1/TX - GPIO #1, also transmit (output) pin for Seriall and Interrupt #3
® #2/SDA - GPIO #2, also the 12C (Wire) data pin. There's no pull up on this pin by default so when

using with 12C, you may need a 2.2K-10K pullup. Also Interrupt #1
#3 / SCL - GPIO #3, also the 12C (Wire) clock pin. There's no pull up on this pin by default so when
using with 12C, you may need a 2.2K-10K pullup. Can also do PWM output and act as Interrupt #0.

® #5 - GPIO #5, can also do PWM output
® #6 - GPIO #6, can also do PWM output and analog input A7
® #9 - GPIO #9, also analog input A9 and can do PWM output. This analog input is connected to a

voltage divider for the lipoly battery so be aware that this pin naturally 'sits' at around 2VDC due to
the resistor divider

#10 - GPIO #10, also analog input A10 and can do PWM output.

#11 - GPIO #11, can do PWM output.

#12 - GPIO #12, also analog input A11 and can do PWM output.

#13 - GPIO #13, can do PWM output and is connected to the red LED next to the USB jack

AO thru A5 - These are each analog input as well as digital I/O pins.

SCK/MOSI/MISO - These are the hardware SPI pins, used by the RFM radio module too! You can use
them as everyday GPIO pins if you don't activate the radio and keep the RFM CS pin high. However,
we really recommend keeping them free as they should be kept available for the radio module. If
they are used, make sure its with a device that will kindly share the SPI bus! Also used to reprogram
the chip with an AVR programmer if you need.

RFM/SemTech Radio Module
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Since not all pins can be brought out to breakouts, due to the small size of the Feather, we use these to
control the radio module

® #8 - used as the radio CS (chip select) pin
® #7 - used as the radio GPIOO / IRQ (interrupt request) pin.
® #4 - used as the radio Reset pin

Since these are not brought out there should be no risk of using them by accident!

There are also breakouts for 3 of the RFM's GPIO pins (101, 102 and 103). You probably wont need these
for most uses of the Feather but they are available in case you need 'em!

Other Pins!

® RST - this is the Reset pin, tie to ground to manually reset the AVR, as well as launch the bootloader

manually

® ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic voltage
(3.3V) but if you need an alternative analog reference, connect it to this pin and select the external
AREF in your firmware. Can't go higher than 3.3V!
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Assembly

We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing
how to use and configure your Feather

Header Options!
Before you go gung-ho on soldering, there's a few options to consider!

The first option is soldering in plain male headers, this lets
you plug in the Feather into a solderless breadboard
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Another option is to go with socket female headers. This
won't let you plug the Feather into a breadboard but it will
let you attach featherwings very easily

We also have 'slim' versions of the female headers, that
are a little shorter and give a more compact shape
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Finally, there's the "Stacking Header" option. This one is
sort of the best-of-both-worlds. You get the ability to plug
into a solderless breadboard andplug a featherwing on

top. But its a little bulky

Prepare the header strip:
Cut the strip to length if necessary. It will be easier to

solder if you insert it into a breadboard - long pins down
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Add the breakout board:

Place the breakout board over the pins so that the short

| e e meE =& - - . - .
FF oo AR e : pins poke through the breakout pads
T And Solder!
Be sure to solder all pins for reliable electrical contact.

Vaa

| (For tips on soldering, be sure to check out our Guide to

—— T Excellent Soldering (https://adafru.it/aTk)).
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Solder the other strip as well.
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You're done! Check your solder joints visually and

continue onto the next steps

Soldering on Female Header

Tape In Place
For sockets you'll want to tape them in place so when you

flip over the board they don't fall out
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Flip & Tack Solder

After flipping over, solder one or two points on each strip,
to 'tack' the header in place
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And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to
Excellent Soldering (https://adafru.it/aTk)).
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You're done! Check your solder joints visually and
continue onto the next steps

Feather M@, WiFi
? (ATHING1500)
88 atswn021618

48MHZ & 3.30
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Antenna Options

Your Feather Radio does not have a built-in antenna. Instead, you have two options for attaching an
antenna. For most low cost radio nodes, a wire works great. If you need to put the Feather into an
enclosure, soldering in uFL and using a uFL to SMA adapter will let you attach an external antenna

Wire Antenna

A wire antenna, aka "quarter wave whip antenna" is low cost and works very welll You just have to cut the
wire down to the right length.

Cut a stranded or solid core wire to the proper length for
the module/frequency

® 433 MHz - 6.5 inches, or 16.5 cm
® 868 MHz - 3.25 inches or 8.2 cm
® 915 MHz - 3 inches or 7.8 cm

Strip a mm or two off the end of the wire, tin and solder
into the ANT pad on the very right hand edge of the
Feather
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That's pretty much it, you're done!

uFL Antenna

If you want an external antenna, you need to do a tiny bit more work but its not too difficult.

You'll need to get an SMT uFL connector, these are fairly standard (http://adafru.it/1661)

You'll also need a uFL to SMA adapter (http://adafru.it/851) (or whatever adapter you need for the antenna
you'll be using, SMA is the most common

Of course, you will also need an antenna of some sort, that matches your radio frequency

Check the bottom of the uFL connector, note that there's
two large side pads (ground) and a little inlet pad. The
other small pad is not used!
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Solder all three pads to the bottom of the Feather

Once done attach your uFL adapter and antenna!
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Power Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer as well as via battery.
There's two ways to power a Feather. You can connect with a MicroUSB cable (just plug into the jack) and
the Feather will regulate the 5V USB down to 3.3V. You can also connect a 4.2/3.7V Lithium Polymer
(Lipo/Lipoly) or Lithium lon (Lilon) battery to the JST jack. This will let the Feather run on a rechargable
battery. When the USB power is powered, it will automatically switch over to USB for power, as well as
start charging the battery (if attached) at 100mA. This happens 'hotswap' style so you can always keep
the Lipoly connected as a 'backup' power that will only get used when USB power is lost.

The JST connector polarity is matched to Adafruit LiPoly batteries. Using wrong polarity batteries
can destroy your Feather
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator and
changeover diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right of the
Reset button). There's also a CHG LED, which will light up while the battery is charging. This LED might
also flicker if the battery is not connected.

The charge LED is automatically driven by the Lipoly charger circuit. It will try to detect a battery
and is expecting one to be attached. If there isn't one it may flicker once in a while when you use
power because it's trying to charge a (non-existant) battery. It's not harmful, and its totally normal!

Power supplies

You have a lot of power supply options here! We bring out the BAT pin, which is tied to the lipoly JST
connector, as well as USB which is the +5V from USB if connected. We also have the 3V pin which has the
output from the 3.3V regulator. We use a 500mA peak AP2112. While you can get 500mA from it, you can't
do it continuously from 5V as it will overheat the regulator. It's fine for, say, powering an ESP8266 WiFi
chip or XBee radio though, since the current draw is 'spiky' & sporadic.
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Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at! That way you can tell
when the battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick around 3.7V for
much of the battery life, then slowly sink down to 3.2V or so before the protection circuitry cuts it off. By
measuring the voltage you can quickly tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9 (a.k.a
analog #7 A7). You can read this pin's voltage, then double it, to get the battery voltage.

#define VBATPIN A9

float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2; // we divided by 2, so multiply back
measuredvbat *= 3.3; // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage

Serial.print("VBat: " ); Serial.println(measuredvbat);

This voltage will 'float' at 4.2V when no battery is plugged in, due to the lipoly charger output, so its not a
good way to detect if a battery is plugged in or not (there is no simple way to detect if a battery is plugged
in)

Alternative Power Options

The two primary ways for powering a feather are a 3.7/4.2V LiPo battery plugged into the JST port ora
USB power cable.

If you need other ways to power the Feather, here's what we recommend:

® For permanent installations, a 5V 1A USB wall adapter (https://adafru.it/duP) will let you plug in a USB
cable for reliable power
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® For mobile use, where you don't want a LiPoly, use a USB battery pack! (https://adafru.it/e2q)
® [f you have a higher voltage power supply, use a 5V buck converter (https://adafru.it/DHs) and wire it
to a USB cable's 5V and GND input (https://adafru.it/DHu)

Here's what you cannot do:

® Do not use alkaline or NiMH batteries and connect to the battery port - this will destroy the LiPoly
charger and there's no way to disable the charger
® Do not use 7.4V RC batteries on the battery port - this will destroy the board

The Feather /s not designed for external power supplies - this is a design decision to make the board
compact and low cost. It is not recommended, but technically possible:

® Connect an external 3.3V power supply to the 3V and GND pins. Not recommended, this may cause
unexpected behavior and the EN pin will no longer. Also this doesn't provide power on BAT or USB
and some Feathers/Wings use those pins for high current usages. You may end up damaging your
Feather.

® Connect an external 5V power supply to the USB and GND pins. Not recommended, this may cause
unexpected behavior when plugging in the USB port because you will be back-powering the USB
port, which could confuse or damage your computer.

Radio Power Draw

You can select the power output you want via software, more power equals more range but of course,
uses more of your battery.

For example, here is the feather 32u4 with RFM69HCW set up for +20dBm power, transmitting a data
payload of 20 bytes

The “25mA quiescent current is the current draw for listening (Y15mA) plus “10mA for the microcontroller.
This can be reduce to amost nothing with proper sleep modes and not putting the module in active listen
mode!
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You still have the 25mA average, but during transmit, it only uses another 20mA not 100mA

If you put the radio to sleep after transmitting, rather than just sitting in receive mode, you can save more
current, after transmit is complete, the average current drops to Y1OmA which is just for the microcontroller
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If you want to reduce even more power, use the Adafruit Sleepdog (https://adafru.it/fp8)library by

installing and adding #include "Adafruit_SleepyDog.h" at the top of your sketch and replace

delay(1000);

with

radio.sleep();
Watchdog.sleep(1

000);

To put the chip into ultra-low-power mode. Note that USB will disconnect so do this after you have done

all your debugging!
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During the super sleepy mode you're using only 300uA (0.3mA)!

Measured Power Data
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While its not easy to get the exact numbers for all of what comprise the 300uA there are a few quiescent
current items on the Feather 32u4:

® 2 x 100K resistors for VBAT measurement = 25uA
® AP2112K 3.3V regulator = 55uA
® MCP73871 batt charger = up to 100uA even when no battery is connected

The rest is probably the Atmega32u4 peripherals including the brown-out detect and bandgap circuitry,
ceramic oscillator, etc. According to the datasheet, with the watchdog and BrownOutDetect enabled, the
lowest possible current is Y30uA (at 5V which is what we're testing at)
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ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to
Ground and it will disable the 3V regulator. The BAT and USB pins will still be powered
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Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino IDE. You will need to be
using version 1.8 or higher for this guide

https://adafru.it/f1P

https://adafru.it/fIP

After you have downloaded and installed the latest version of Arduino IDE, you will need to start the
IDE and navigate to the Preferences menu. You can access it from the File menu in Windows or Linux, or

the Arduino menu on OS X.

-
Blink | Arduino 1.8.2

= | B

Edit Sketch Tools Help

New

Open...

Open Recent
Sketchbook
Examples
Close

M Save

Save As...

Page Setup
Print

Preferences

Quit

Ctrl+ N
Ctrl+0

Ctrl+W
Ctrl+5
Ctrl+Shift+5

Ctrl+Shift+P
Ctrl+P

Ctrl+ Comma

Ctrl+Q

»

m
il

A dialog will pop up just like the one shown below.
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[ ] Preferences

Sketchbook location:

/Users /todd/Documents /Arduino Browse
Editor language: = System Default + (requires restart of Arduino)
Editor font size: 10 (requires restart of Arduino)
Show verbose output during: compilation upload
Compiler warnings: = None H

Display line numbers
v Verify code after upload
Use external editor
v Check for updates on startup
v Update sketch files to new extension on save (.pde -> .ino)

v save when verifying or uploading

Proxy Settings

Server (HTTP): Port (HTTP): 8080
Server: (HTTPS) Port (HTTPS): 8443
Username: Password:

Additional Boards Manager URLs: |

More preferences can be edited directly in the file
/Users /todd/Library/Arduinol5/preferences.txt
(edit only when Arduino is not running)

oK Cancel

We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is comma
separated, and you will only have to add each URL once. New Adafruit boards and updates to existing
boards will automatically be picked up by the Board Manager each time it is opened. The URLs point to
index files that the Board Manager uses to build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs on the
Arduino IDE wiki (https://adafru.it/f7U). We will only need to add one URL to the IDE in this example, but
you can add multiple URLS by separating them with commas . Copy and paste the link below into

the Additional Boards Manager URLs option in the Arduino IDE preferences.

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json
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Settings | Network

Sketchbook location:

C:\WsersYadyada'\Dropbox\ArduinoSketches
Editor language: :Syshem Default - (requires restart of Arduino)

Editor font size: 12

Interface scale: Automatic | 100 % (requires restart of Arduing)

Show verbose output during: compilation upload |
Compiler warnings: :None - I
[ Display line numbers i
[ Enable Code Folding

Verify code after upload

[] Use external editor
Check for updates on startup
Update sketch files to new extension on save (.pde -> .ino)

Save when verifying or uploagi

Additional Boards Manager URLs:f |https: f{adafruit.com/package_adafruit_index.json i
t

More preferences can be edited directly in the file Enter a comma separated list of urlsl

C:\UsersVadyada\AppDataiLocal\Arduino 15 preferences. bt f
(edit only when Arduine is not running) i

Here's a short description of each of the Adafruit supplied packages that will be available in the Board
Manager when you add the URL:

® Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, ItsyBitsy 32u4, Trinket, &
Trinket Pro.

® Adafruit SAMD Boards - Includes support for Feather MO and M4, Metro MO and M4, ItsyBitsy MO and
M4, Circuit Playground Express, Gemma MO and Trinket MO

® Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora, Feather 32u4,
Micro and Leonardo using the arcore project (https://adafru.it/eSl).

If you have multiple boards you want to support, say ESP8266 and Adafruit, have both URLs in the text
box separated by a comma (,)

Once done click OK to save the new preference settings. Next we will look at installing boards with the
Board Manager.

Now continue to the next step to actually install the board support package!
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Using with Arduino IDE

Since the Feather 32u4 uses an ATmega32u4 chip running at 8 MHz, you can pretty easily get it working
with the Arduino IDE. Many libraries (including the popular ones like NeoPixels and display) work great with
the '32u4 and 8 MHz clock speed.

Now that you have added the appropriate URLs to the Arduino IDE preferences, you can open the Boards
Manager by navigating to the Tools->Board menu.

R
Iink | Arduino 1.8.4

File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch

Fix Encoding 8 Reload

Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

WiFil01 Firmware Updater

Board: "Arduino Pro or Pro Mini"

Processor: "ATmega328P (3.3V, 8 MHz)" EpadsiVanagee

E e -

Once the Board Manager opens, click on the category drop down menu on the top left hand side of the
window and select Contributed. You will then be able to select and install the boards supplied by the URLs
added to the prefrences. In the example below, we are installing support for Adafruit AVR Boards, but the
same applies to all boards installed with the Board Manager.

Type Al L3 ¥ | |Filter your search

Arduino AVR Boards Buwit-In by Arduine version 1.8.7 INSTALLED

Boards Induded in this package:

Ardulna Yo, Anduing Una, Ardulno Diecimila, Ardulno Mand, Ardulng Mega, Arduing MegaADK, Arduing Leonardo, Andulng Micno, Ardulng Esplara,
Arduing Mini; Arduing Ethernet, Arduing Fio, Arduing BT, Arduing LilyPadUSB, Arduing Lilypad, Ardisne Pro, Arduing ATMegaiG,; Arduing Robat
Control, Arduing Robot Motor, Arduing Gemma.

Online hele

e ife

Arduing SAM Boards (32-bits ARM Corfex-M3] by Arduine
Boards induded in this package:

Argduing D,

Online help

Hare infa

Intel iIS86 Boards by Intel
Boards included in this package:
Galileo.

Mare info

Next, quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You should
now be able to select and upload to the new boards listed in the Tools->Board menu.
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woid setup() {
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}
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] r

L

Install Drivers (Windows 7 Only)

ay 2014
Zgera

13 by Scott Fitzge

1d

7 // the setup function runs conce when you press resg

/f initialize digital pin 13 as an cutput.
pinMode (13, OUTPEUT):

[/ the loop function runs over and over again forew

Blink | Arduino 16.5 —
File Edit Sketch [Tools Help
Auto Format Ctrl+T
Archive Sketch
Fix Encoding & Reload . .
. . . . Arduino Ethernet
17 Serial Monitor Ctrl+Shift+M . .
2 Blink Arduine Fio
3 Turns on Board: "Arduino/Genuino Uno"” Arduino BT
‘ ) Port LilyPad Arduino USB
3 Most Ard
6 eonardd . LilyPad Ardui
6 Leonardg Programmer: "USBtinyI5P" e
7 pin the Arduino Pro or Pro Mini
5 the do Burn Bootloader
- £ doe Arduino NG or older
g
10 This example code is in the public domain. Arduino Robot Control
11 Arduino Robot Motor
12 modified & M Arduine Gemma

Arduino ARM (32-bits) Boards
Arduino Due (Programming Port)
Arduino Due (Mative USE Port)

Adafruit Boards
Adafruit Flora

Adafruit Bluefruit Micro
Adafruit Gemma 8MHz
Adafruit Feather 32ud

When you plug in the Feather, you'll need to possibly install a driver

Windows 10 folks can skip this, the drivers now come built into Windows 10!

Click below to download our Driver Installer

https://adafru.it/ABO

Download and run the installer

https://adafru.it/ABO

P

Opening adafruit_drivers.exe

You have chosen to open:
[n"] adafruit_drivers.exe
which is: Binary File (13.6 ME)

from: https://github-cloud.s3.amazonaws.com

Would you like to save this file?

| SoveFile | [ Concel |

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to click through the
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license

-
* Adafruit Board Dri\rers:kicense Agreement = —

Please review the license agreement before installing Adafruit board
drivers. If you accept all terms of the agreement, dick I Agree.

hhis program will allow you to install Windows drivers for -

Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

Mote you can uninstall any of the installed drivers by using
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).

hardware that Adafruit Industries produces. Please support (d

Cancel | Mullsoft Install Syskem 3,003 I Agree

Select which drivers you want to install:

Chedk the board drivers below that you would like to install. Clids install to
start the installation.

Select board drivers to install: Feather 32u4, Feather MO, Feather MO Es
Feather WICED
Trinket f Pro Trinket / Gemma (USBtnyISF)

] Arduine Gemma
] Feather HUZZAH ESP8266 (SiLabs CP210%]
[ Metro 328 / Metro Mini 328 (FTDI VCP and

F

Cancel | Mullsaft Install Syskern v3,02,1 < Back | Install I

Click Install to do the installin'
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Blink

Now you can upload your first blink sketch!

Plug in the Feather 32u4 and wait for it to be recognized by the OS (just takes a few seconds). It will create
a serial/COM port, you can now select it from the dropdown, it'll even be 'indicated' as Feather 32u4!

L v

Blink | Arduino 1.6.5 - —
-

File Edit Sketch ETooIs Help

Auto Format Ctrl+T
Archive Sketch
Blink s Fix Encoding & Reload
1/ Serial Monitor Ctrl+Shift+M
2 Blink
3| Turns on Board: "Adafruit Feather 32u4" »pe second, repeatedly.
i_l Port Serial ports
b=
- . COML (Adafruit Feather 32ud)
- Programmer: "USBtinyISP"
7 COom12
Burn Bootloader

COML05 (Adafruit Feather 32ud)

Now load up the Blink example

// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode (13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
digitalWrite(13, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000) ; // wait for a second
digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
delay(1000) ; // wait for a second

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the delay() calls.

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't
auto-reboot into the bootloader, double-click the RST button to get back into the bootloader. The red LED
will pulse, so you know that its in bootloader mode. Do the reset button double-press right as the Arduino
IDE says its attempting to upload the sketch, when you see the Yellow Arrow lit and the Uploading... text
in the status bar.
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atcommand | Arduine 1.6.4 E@&J

T — ;- Ll
File Edit Sketch Tools Help

BluefruitConfic.h

Sketch us

bal

Adafruit Bluefruit Micro on CORMGS

Don't click the reset button before uploading, unlike other bootloaders you want this one to run at the time
Arduino is trying to upload

Ubuntu & Linux Issue Fix

If you're on Linux, and are seeing multi-second delays connecting to the serial console, or are seeing "AT"
and other gibberish when you connect, follow the steps on this page. (https://adafru.it/iOE)
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Feather HELP!

Even though this FAQ is labeled for Feather, the questions apply to ItsyBitsy's as well!

My ltsyBitsy/Feather stopped working when | unplugged the USB!

A lot of our example sketches have a
while (!Serial);
line in setup(), to keep the board waiting until the USB is opened. This makes it a lot easier to debug a

program because you get to see all the USB data output. If you want to run your Feather without USB
connectivity, delete or comment out that line

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-radio-with-rfm69hcw-module Page 42 of 79



My Feather never shows up as a COM or Serial port in the Arduino
IDE

A vast number of Itsy/Feather 'failures' are due to charge-only USB cables
We get upwards of 5 complaints a day that turn out to be due to charge-only cables!
Use only a cable that you know is for data syncing

If you have any charge-only cables, cut them in half throw them out. We are serious! They tend to be
low quality in general, and will only confuse you and others later, just get a good data+charge USB
cable.

A quality USB port is critical. Avoid plugging into USB keyboards and when possible use a USB-2 HUB
to avoid USB3 issues.
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Ack! | "did something" and now when | plug in the Itsy/Feather, it
doesn't show up as a device anymore so | cant upload to it or fix it...

No problem! You can 'repair' a bad code upload easily. Note that this can happen if you set a watchdog
timer or sleep mode that stops USB, or any sketch that 'crashes' your board

1. Turn on verbose upload in the Arduino IDE preferences

2. Plug in ltsy or Feather 32u4/MO, it won't show up as a COM/serial port that's ok

3. Open up the Blink example (Examples->Basics->Blink)

4. Select the correct board in the Tools menu, e.g. Feather 32u4, Feather MO, Itsy 32u4 or MO

(physically check your board to make sure you have the right one selected!)

Compile it (make sure that works)

Click Upload to attempt to upload the code

7. The IDE will print out a bunch of COM Ports as it tries to upload. During this time, double-click the
reset button, you'll see the red pulsing LED that tells you its now in bootloading mode

8. The board will show up as the Bootloader COM/Serial port

9. The IDE should see the bootloader COM/Serial port and upload properly

o u
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.
Blink | Arduino 1.65 =

File Edit Sketch Tools Help

| can't get the Itsy/Feather USB device to show up - | get "USB Device
Malfunctioning" errors!

This seems to happen when people select the wrong board from the Arduino Boards menu.

If you have a Feather 32u4 (look on the board to read what it is you have) Make sure you select Feathet
32u4 for ATMega32u4 based boards! Do not use anything else, do not use the 32u4 breakout board
line.
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If you have a Feather MO (look on the board to read what it is you have) Make sure you select Feather
MO - do not use 32u4 or Arduino Zero

If you have a ltsyBitsy MO (look on the board to read what it is you have) Make sure you select ItsyBitsy
MO - do not use 32u4 or Arduino Zero

I'm having problems with COM ports and my ltsy/Feather 32u4/MO

Theres two COM ports you can have with the 32u4/MO, one is the user port and one is the bootloader
port. They are not the same COM port number!

When you upload a new user program it will come up with a user com port, particularly if you use Serial
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in your user program.

If you crash your user program, or have a program that halts or otherwise fails, the user COM port can
disappear.

When the user COM port disappears, Arduino will not be able to automatically start the bootloader
and upload new software.

So you will need to help it by performing the click-during upload procedure to re-start the bootloader,
and upload something that is known working like "Blink"

| don't understand why the COM port disappears, this does not
happen on my Arduino UNO!

UNO-type Arduinos have a seperate serial port chip (aka "FTDI chip" or "Prolific PL2303" etc etc) which
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handles all serial port capability seperately than the main chip. This way if the main chip fails, you can
always use the COM port.

MO and 32u4-based Arduinos do not have a seperate chip, instead the main processor performs this
task for you. It allows for a lower cost, higher power setup...but requires a little more effort since you will
need to 'kick' into the bootloader manually once in a while

I'm trying to upload to my 32u4, getting "avrdude: butterfly_recv():
programmer is not responding" errors
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This is likely because the bootloader is not kicking in and you are accidentally trying to upload to the
wrong COM port

The best solution is what is detailed above: manually upload Blink or a similar working sketch by hand
by manually launching the bootloader

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-radio-with-rfm69hcw-module Page 49 of 79



I'm trying to upload to my Feather MO, and | get this error "Connecting
to programmer: .avrdude: butterfly_recv(): programmer is not
responding”

You probably don't have Feather MO selected in the boards drop-down. Make sure you selected
Feather MO.
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I'm trying to upload to my Feather and i get this error "avrdude:
ser_recv(): programmer is not responding"

You probably don't have Feather MO / Feather 32u4 selected in the boards drop-down. Make sure you
selected Feather MO (or Feather 32u4).
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| attached some wings to my Feather and now | can't read the battery
voltage!

Make sure your Wing doesn't use pin #9 which is the analog sense for the lipo battery!
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The yellow LED Is flickering on my Feather, but no battery is plugged
in, why is that?

The charge LED is automatically driven by the Lipoly charger circuit. It will try to detect a battery and is
expecting one to be attached. If there isn't one it may flicker once in a while when you use power
because it's trying to charge a (non-existant) battery.

It's not harmful, and its totally normal!
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Using the RFM69 Radio

This page is shared between the RFM69 breakout and the
all-in-one Feather RFM69's. The example code and overall
functionality is the same, only the pinouts used may differ!
Just make sure the example code is using the pins you
have wired up.

Before beginning make sure you have your Arduino or Feather working smoothly, it will make this part a
lot easier. Once you have the basic functionality going - you can upload code, blink an LED, use the serial
output, etc. you can then upgrade to using the radio itself.

Note that the sub-GHz radio is not designed for streaming audio or video! It's best used for small packets
of data. The data rate is adjustable but its common to stick to around 19.2 Kbps (thats bits per second).
Lower data rates will be more successful in their transmissions

You will, of course, need at least two paired radios to do any testing! The radios must be matched in
frequency (e.g. 900 MHz & 900 MHz are ok, 900 MHz & 433 MHz are not). They also must use the same
encoding schemes, you cannot have a 900 MHz RFM69 packet radio talk to a 900 MHz RFM9x LoRa
radio.

"Raw" vs Packetized

The SX1231 can be used in a 'raw rx/tx' mode where it just modulates incoming bits from pin #2 and sends
them on the radio, however there's no error correction or addressing so we wont be covering that
technique.
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Instead, 99% of cases are best off using packetized mode. This means you can set up a recipient for your
data, error correction so you can be sure the whole data set was transmitted correctly, automatic re-
transmit retries and return-receipt when the packet was delivered. Basically, you get the transparency of a
data pipe without the annoyances of radio transmission unreliability

Arduino Libraries

These radios have really great libraries already written, so rather than coming up with a new standard we
suggest using existing libraries such as LowPowerlLab's REM69 Library (https://adafru.itymCz)
and AirSpayce's Radiohead library (https://adafru.it/mCA) which also suppors a vast number of other radios

These are really great Arduino Libraries, so please support both companies in thanks for their efforts!

We recommend using the Radiohead library - it is very cross-platform friendly and used a lot in the
community!

RadioHead Library example

To begin talking to the radio, you will need to download our small fork of the Radiohead from our github
repository (https://adafru.it/vgE). You can do that by visiting the github repo and manually downloading or,
easier, just click this button to download the zip

https://adafru.it/vgF

https://adafru.it/vgF

Rename the uncompressed folder RadioHead and check that the RadioHead folder contains files like
RH_RFM69.cpp and RH_RFM69.h (and many others!)

Place the RadioHead library folder in your arduinosketchfolder/libraries/ folder.
You may need to create the libraries subfolder if it's your first library. Restart the IDE.

We also have a great tutorial on Arduino library installation at:
http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use (https://adafru.it/aYM)

Basic RX & TX example

Lets get a basic demo going, where one radio transmits and the other receives. We'll start by setting up
the transmitter

Basic Transmitter example code

This code will send a small packet of data once a second to another RFM69 radio, without any addressing.
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Open up the example RadioHead -> feather -> RadioHead69_RawDemo_TX

Load this code into your Transmitter Arduino or Feather!

—_ T

Radihesits FanBeneTO riare 1

Edit Sketch Tools Help
Mew Ctrl+M
Open... Ctrl+O
Open Recent » OLED
Sketchbook L4
Examples & X Lient
Close Cerl+W PubSubClient ’ ::ig:;ngcz ::Zressing or
Save Ctrl+5 Radio 11 dAn nnt need the higher
SaveAs..  Ctrl+ShiftsS fadiohiead == '
RDAS807M cclld 4
gaosSSpiel it RFM69 feather Featherdx DemoTXRX_OLED
Bupt il RGBDigit mrf8g Featherdx_RX
PreieEnees iR T o RGBmatrixPanel nrf24 FeatherSx_TX
Robot Control nrf51 RadioHead69_AddrDemoTXRX_OLED
e creQ RTClib nrf905 RadioHead69_RawDemo_RX
#include <Adafruit:SSD1306 Sha f22 RadioHeadt9_RawDemo_TX
SHT1x rf24 RadioHeadb9_RawDemoTXRX_OLED
Senartl O 0 wl

Before uploading, check for the #define FREQUENCY RF69_915MHZ line and comment that out
(and uncomment the line above) to match the frequency of the hardware you're using

These examples are optimized for the Feather 32u4/MO. If you're using differnet wiring,
uncomment/comment/edit the sections defining the pins depending on which chipset and wiring
you are using! The pins used will vary depending on your setup!

Once uploaded you should see the following on the serial console

f B
COM36 (Adafruit Feather MO) ESREERTS

Send

»

Feather RFMEY TX Test!

RFMGY radioc init OK!

EFMA9 radic @915 MHz

Sending Hello World #0

Ho reply, 13 another RFME9 listening?
Sending Hellc World #1

Ho reply, is another RFME9 listening?
Sending Hello World #2

No reply, is another RFME9 listening?
Sending Hello World 3

Ho reply, is ancther RFME&9 listening?
Sending Hellc World #4

Ho reply, 13 another RFME9 listening?
Sending Hello World #5

No reply, is another RFME9 listening?
Sending Hello World #6 -

m

] Autoscrol BothNL&CR | | 115200 baud
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Now open up another instance of the Arduino IDE - this is so you can see the serial console output from
the TX device while you set up the RX device.

Basic receiver example code

This code will receive and reply with a small packet of data.
Open up the example RadioHead -> feather -> RadioHead69_RawDemo_RX

Load this code into your Receiver Arduino/Feather!

— —
T G

Edit Sketch Tools Help

MNew Ctrl+N
Open... Ctrl+0
Open Recent »{OLED
Sketchbook ¥
bampls Radi . Llient
Close Crl+W iy "
Save Ctrl+5 RadioHead ask Y her
SaveAs..  Ctrl«ShiftsS FREELL =iv 0
RFMBE feather Featherfx_DemoTXRX_OLED
PageSetup  Ctr+Shift+P RGBDigit rrfgg FeatherSx RX
Print Ctrl+P RGBmatrixPanel nrf24 Featherdx TX
Preferences  Cii+Comma Rebot Control nrf51 RadioHead59_AddrDemoTXRX_OLED
. RTClib nrfa05 RadicHead88_RawDemo_RX
__ | cubeq Sha 22 RadioHezd69_RawDemo_TX
#include <Adarruir.:SSD1306 SHT1x rf2d RadicHead69_RawDemoTXRX_OLED
yyyyyyyyyyyy OLED Setup SmartLCD rfﬁg '
Ldafruit_S5SD1306 oled - ad Softfassing iZE '
SpacebrewYun serial r
#if defined(ESP8266) SPI_VFD simulator ¥
#define BUTTON A 0 S T

Before uploading, check for the #define FREQUENCY RF69_915MHZ line and comment that out
(and uncomment the line above) to match the frequency of the hardware you're using

These examples are optimized for the Feather 32u4/MO. If you're using differnet wiring,
uncomment/comment/edit the sections defining the pins depending on which chipset and wiring
you are using! The pins used will vary depending on your setup!

Now open up the Serial console on the receiver, while also checking in on the transmitter's serial console.
You should see the receiver is...well, receiving packets
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-
@ COM34 (Adafruit Feather 32ud)

Feather RFMES RX Test! il

RFM&9 radio init OK! I
RFM&Y radic @915 MH=z
Received [15]: Hellc World #78

m

R35I: -25 N
Sent a reply (]
Received [15]: Hello World 479 [
R55I: -2¢& N
Sent & reply (]
Beceiwed [15]: Hellc World #80 (]
R35I: -2& N
Sent a reply (]
Beceiwved [15]: Hello World #81 | |
C1& it BothNL&CR | |115200baud - ||

ILE .

And, on the transmitter side, it is now printing Got Reply after each transmisssion because it got a reply
from the receiver

p
@ COM36 (Adafruit Feather MO)

TUL & LoHLIF .

Sending Hellc World #79

HIId I-IIU Uook O Fou

Got & reply: End hello back
Sending Hello World #820
Got & reply: Bnd hello back
Sending Hello World #21
Got & reply: And helloc back
Sending Hellc World #82
Got & reply: End hello back
Sending Hellc World #83
Got & reply: BEnd hello back

to

to

to

to

to

you

you

you

you

you

||Sending Hello World #84 I

Got & reply: Bnd hello back to you |E
Sending Helloc World #85

| Got & reply: BEnd hello back to you
Sending Hellc World #86
Got & reply: BEnd hello back to you

1 Sending Hello World #87 i
] Autoscrol BothNL&CR | | 115200 baud

= = = A

That's pretty much the basics of it! Lets take a look at the examples so you know how to adapt to your own
radio network

Radio Freq. Config

Each radio has a frequency that is configurable in software. You can actually tune outside the
recommended frequency, but the range won't be good. 900 MHz can be tuned from about 850-950MHz
with good performance. 433 MHz radios can be tuned from 400-460 MHz or so.
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// Change to 434.0 or other frequency, must match RX's freq!
#define RF69 FREQ 915.0

For all radios they will need to be on the same frequency. If you have a 433MHz radio you will want to
stick to 433. If you have a 900 Mhz radio, go with 868 or 915MHz, just make sure all radios are on the
same frequency

Configuring Radio Pinout

At the top of the sketch you can also set the pinout. The radios will use hardware SPI, but you can select
any pins for RFM69_CS (an output), RFM_IRQ (an input) and RFM_RST (an output). RFM_RST is manually
used to reset the radio at the beginning of the sketch. RFM_IRQ must be an interrupt-capable pin. Check
your board to determine which pins you can use!

Also, an LED is defined.

For example, here is the Feather 32u4 pinout

#if defined (_ AVR ATmega32U4 ) // Feather 32u4 w/Radio

#define RFM69 CS 8

#define RFM69 INT 7

#define RFM69 RST 4

#define LED 13
#endif

If you're using a Feather MO, the pinout is slightly different:

#if defined (ARDUINO SAMD FEATHER MO) // Feather MO w/Radio

#define RFM69 CS 8

#define RFM69 INT B

#define RFM69 RST 4

#define LED 13
#endif

If you're using an Arduino UNO or compatible, we recommend:

#if defined (_ AVR ATmega328P ) // UNO or Feather 328P w/wing
#define RFM69 INT 3 //

#define RFM69 CS 4 //

#define RFM69 RST 2 // "A"

#define LED 13
#endif

If you're using a FeatherWing or different setup, you'll have to set up the #define statements to match your

wiring

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-radio-with-rfm69hcw-module Page 60 of 79



You can then instantiate the radio object with our custom pin numbers. Note that the IRQ is defined by the
IRQ pin not number (sometimes they differ).

// Singleton instance of the radio driver
RH RF69 rf69(RFM69 CS, RFM69 INT);

Setup

We begin by setting up the serial console and hard-resetting the RFM69

void setup()

{

Serial.begin(115200);

//while (!Serial) { delay(l); } // wait until serial console is open, remove if not tethered
to computer

pinMode (LED, OUTPUT);
pinMode (RFM69 RST, OUTPUT);
digitalWrite(RFM69 RST, LOW);

Serial.println("Feather RFM69 RX Test!");
Serial.println();

// manual reset
digitalWrite(RFM69 RST, HIGH);
delay(10);

digitalWrite(RFM69 RST, LOW);
delay(10);

If you are using a board with 'native USB' make sure the while (ISerial) line is commented out if you are not
tethering to a computer, as it will cause the microcontroller to halt until a USB connection is made!
Initializing Radio

Once initialized, you can set up the frequency, transmission power, radio type and encryption key.

For the frequency, we set it already at the top of the sketch

For transmission power you can select from 14 to 20 dBi. Lower numbers use less power, but have less
range. The second argument to the function is whether it is an HCW type radio, with extra amplifier. This
should a/ways be set to true!

Finally, if you are encrypting data transmission, set up the encryption key
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if ('rf69.init()) {
Serial.println("RFM69 radio init failed");
while (1);

}
Serial.println("RFM69 radio init OK!");

// Defaults after init are 434.0MHz, modulation GFSK Rb250Fd250, +13dbM (for low power module)
// No encryption
if (!'rf69.setFrequency(RF69 FREQ)) {

Serial.println("setFrequency failed");

}

// If you are using a high power RF69 eg RFM69HW, you *must* set a Tx power with the
// ishighpowermodule flag set like this:
rf69.setTxPower(20, true); // range from 14-20 for power, 2nd arg must be true for 69HCW

// The encryption key has to be the same as the one in the server
uint8 t key[] = { 06x01, 0x02, 0x03, 0x04, 0x05, 0x06, 0x07, 0x08,

0x01, 0x02, Ox03, 0x04, 0x05, 0x06, O0x07, 0x08};
rf69.setEncryptionKey(key);

Basic Transmission Code

If you are using the transmitter, this code will wait 1 second, then transmit a packet with "Hello World #"
and an incrementing packet number, then check for a reply
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void loop() {
delay(1000); // Wait 1 second between transmits, could also 'sleep' here!

char radiopacket[20] = "Hello World #";
itoa(packetnum++, radiopacket+13, 10);
Serial.print("Sending "); Serial.println(radiopacket);

// Send a message!
rf69.send((uint8 t *)radiopacket, strlen(radiopacket));
rf69.waitPacketSent();

// Now wait for a reply
uint8 t buf[RH RF69 MAX MESSAGE LEN];
uint8 t len = sizeof(buf);

if (rf69.waitAvailableTimeout(500)) {
// Should be a reply message for us now
if (rf69.recv(buf, &len)) {
Serial.print("Got a reply: ");
Serial.println((char*)buf);
Blink (LED, 50, 3); //blink LED 3 times, 50ms between blinks

} else {
Serial.println("Receive failed");
}
} else {
Serial.println("No reply, is another RFM69 listening?");

}
}

Its pretty simple, the delay does the waiting, you can replace that with low power sleep code. Then it
generates the packet and appends a number that increases every tx. Then it simply calls send()
waitPacketSent() to wait until is is done transmitting.

It will then wait up to 500 milliseconds for a reply from the receiver with waitAvailableTimeout(500) . If there
is a reply, it will print it out. If not, it will complain nothing was received. Either way the transmitter will
continue the loop and sleep for a second until the next TX.

Basic Receiver Code

The Receiver has the same exact setup code, but the loop is different
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void loop() {
if (rfé69.available()) {

// Should be a message for us now

uint8 t buf[RH RF69 MAX MESSAGE LEN];

uint8 t len = sizeof(buf);

if (rf69.recv(buf, &len)) {
if (!len) return;
buf[len] = 0;
Serial.print("Received [");
Serial.print(len);
Serial.print("]: ");
Serial.println((char*)buf);
Serial.print("RSSI: ");
Serial.println(rf69.lastRssi(), DEC);

if (strstr((char *)buf, "Hello World")) {
// Send a reply!
uint8 t data[] = "And hello back to you";
rf69.send(data, sizeof(data));
rf69.waitPacketSent();
Serial.println("Sent a reply");
Blink(LED, 40, 3); //blink LED 3 times, 40ms between blinks

}
} else {
Serial.println("Receive failed");

Instead of transmitting, it is constantly checking if there's any data packets that have been received.
available() will return true if a packet with the proper encryption has been received. If so, the receiver

prints it out.

It also prints out the RSSI which is the receiver signal strength indicator. This number will range from about
-15 to -80. The larger the number (-15 being the highest you'll likely see) the stronger the signal.

If the data contains the text "Hello World" it will also reply to the packet.

Once done it will continue waiting for a new packet

Basic Receiver/Transmitter Demo w/OLED

OK once you have that going you can try this example, RadioHead69_RawDemoTXRX_OLED. We're
using the Feather with an OLED wing but in theory you can run the code without the OLED and connect
three buttons to GPIO #9, 6, and 5 on the Feathers. Upload the same code to each Feather. When you
press buttons on one Feather they will be printed out on the other one, and vice versa. Very handy for
testing bi-directional communication!
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RadioHead69_RawDemo’
[[Fite] Editsketch Tools Help

Mew Ctrl+M
Open... Ctrl+0
| Open Recent » OLED
Sketchbook L4
Examples & ) liens
] sageing clien
Close Ctel+W Eadic ¢ ssing or
Save Ctrl+S RadioHead ask *| the higher
SaveAs..  Cirl+Shift+S BRZSEE/RA = D
RFMG9 feather Feather9x_DemoTXRX_OLED
EageSetipRShShitleH RGEDigit mrf8g Featherdx_RX
[m Gty RGBmatrixPanel nif24 Featherdx_TX
Irigme=  SreTrmne Robot Control nrf51 RadioHeadbd_AddrDemoTXRX_OLED
RTClib nrf90s RadioHead69_RawDemo_RX
o Ou ci@ Sha 22 RadioHead69_RawDemo_TX
#include <Adafruit_SSD1306  SHTIx rf24 RadioHead69_RawDemoTXRX_OLED

This demo code shows how you can listen for packets and also check for button presses (or sensor data
or whatever you like) and send them back and forth between the two radios!

Addressed RX and TX Demo

OK so the basic demo is well and good but you have to do a lot of management of the connection to make
sure packets were received. Instead of manually sending acknowledgements, you can have the RFM69
and library do it for you! Thus the Reliable Datagram part of the RadioHead library.

Load up the RadioHead69_AddrDemo_RX and RadioHead69_AddrDemo_TX sketches to each of your
boards

This example lets you have many 'client' RFM69's all sending data to one 'server'

Each client can have its own address set, as well as the server address. See this code at the beginning:

// Where to send packets to!

#define DEST ADDRESS 1

// change addresses for each client board, any number :)
#define MY ADDRESS 2

For each client, have a unique MY_ADDRESS. Then pick one server that will be address #1

Once you upload the code to a client, you'll see the following in the serial console:
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Because the data is being sent to address #1, but #1is not acknowledging that data.

[ =zl COM34 (Adafruit Feather 32ud)

| [[send |

Feather Lddressed RFMES TX Testc!

RFMGY radioc init OK!

RFMA9 radioc @915 MHz

Sending Hellec World #0
Sending failed (no ack)
Sending Helleo World #1
Sending failed (no ack)
Sending Hello World #2
Sending failed (no ack)

m

—

[7] Autoscral [BothNL&CR v [115200baud |

If you have the server running, with no clients, it will sit quietly:

-

)
COM36 (Adafruit Feather MO} E=EERTS

| =N
Feather Addressed RFM&9 RX Test! Ji |
RFM&9 radio init OK!
BFM69 radic @915 MHz
Jl
A
7] Autoscrol [BothNL&CR  + |115200baud +

Turn on the client and you'll see acknowledged packets!
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COM34 (Adafruit Feather 32ud)

Feather Lddressed RFMES TY Test!

RFMGY radio init OK!

RFMA9 radioc @915 MHz

Sending Hellec World #0

|Got reply from #1 [RSSI :-26] : And hel
|Sending Hello World #1

Got reply from #1 [R55I :-25] : And hel
Sending Hello World #2

Got reply from #1 [R55I :-26] : And hel
Sending Hello World #3

Got reply from #1 [RS5I :-28] : And hel
Sending Helleo World #4

Got reply from #1 [RS5I :-26] : And hel

lo back to you

lo back to you

lo back to you

lo back to you

lo back to you

m

-

And the server is also pretty happy

[] Autoscral BothNL&CR | |115200 baud |
L. 7
P' EI ™
&9 COM36 (Adafruit Feather MO) = |

Feather Zddressed RFMe9 RX Test! -
RFM&Y radic initc OH!

RFM&Y radio @915 MHz =
Got packet from #2 [RSSI :-26] : Hello Werld #0

Got packet from #2 [R55I :-31] : Helle World #1 |
Got packet from #2 [R55I :-30] : Helle World #2

Got packet from #2 [R55I :-31] : Helle World #3

ot packet from #2 [R55T :-31] : Hello World #4

Got packet from #2 [R55T :-30] : Hello World #5

Got packet from #2 [R55T :-30] : Hello World #6

Got packet from #2 [RSSI :-31] : Helloc Werld #7

Got packet from #2 [R55I :-31] : Helle World #8

Got packet from #2 [R55T :-30] : Helleo World #9 sl

[[] Autoscral BothML&CR | |115200 baud |

The secret sauce is the addition of this new object:

// Class to manage message delivery and receipt, using the driver declared above

RHReliableDatagram rf69 manager(rf69, MY ADDRESS);

Which as you can see, is the manager for the RFM69. In setup() you'll need to init it, although you still

configure the underlying rfm69 like before:

if (!'rf69 manager.init()) {
Serial.println("RFM69 radio init failed");
while (1);
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And when transmitting, use sendToWait which will wait for an ack from the recepient (at DEST_ADDRESS)

if (rf69 manager.sendtoWait((uint8 t *)radiopacket, strlen(radiopacket), DEST ADDRESS)) {

on the 'other side' use the recvFromAck which will receive and acknowledge a packet

// Wait for a message addressed to us from the client
uint8 t len = sizeof(buf);
uint8 t from;

if (rf69 manager.recvfromAck(buf, &len, &from)) {

That function will wait forever. If you'd like to timeout while waiting for a packet, use recvfromAckTimeout
which will wait an indicated # of milliseconds

if (rf69 manager.recvfromAckTimeout (buf, &len, 2000, &from))
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Radio Range F.A.Q.

Which gives better range, LoRa or RFM69?

All other things being equal (antenna, power output, location) you will get better range with LoRa than
with RFM69 modules. We've found 50% to 100% range improvement is common.
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What ranges can | expect for RFM69 radios?

The RFM69 radios have a range of approx. 500 meters line of sight with tuned uni-directional antennas.
Depending on obstructions, frequency, antenna and power output, you will get lower ranges -
especially if you are not line of sight.
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What ranges can | expect for RFM9X LoRa radios?

The RFM9x radios have a range of up to 2 km line of sight with tuned uni-directional antennas.
Depending on obstructions, frequency, antenna and power output, you will get lower ranges -
especially if you are not line of sight.
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| don't seem to be getting the range advertised! Is my module
broken?

Your module is probably notbroken. Radio range is dependant on a /ot of things and all must be
attended to make sure you get the best performance!

1.

w

Tuned antenna for your frequency - getting a well-tuned antenna is incredibly important. Your
antenna must be tuned for the exact frequency you are using

Matching frequency - make sure all modules are on the same exact frequency

Matching settings - all radios must have the same settings so they can communicate

Directional vs non-directional antennas - for the best range, directional antennas like Yagi will
direct your energy in one path instead of all around

Good power supply - a nice steady power supply will keep your transmissions clean and strong
Max power settings on the radios - they can be set for higher/lower power! Don't forget to set them
to max.

Line of sight - No obstructions, walls, trees, towers, buildings, mountains, etc can be in the way of
your radio path. Likewise, outdoors is way better than indoors because its very hard to bounce
radio paths around a building

Radio transmission speed - trying to transmit more data faster will be hard. Go for small packets,
with lots of retransmissions. Lowering the baud rate on the radio (see the libraries for how to do
this) will give you better reliability
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How do | pick/design the right antenna?

Various antennas will cost diferent amounts and give you different directional gain. In general, spending
a lot on a large fixed antenna can give you better power transfer if the antenna is well tuned. For most
simple uses, a wire works pretty well

The ARRL antena book is recommended if you want to learn how to do the modeling and
analysis (https://adafru.it/sdN)

But nothing beats actual tests in your environment!
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What frequency is my module?

Look for a little colored paint dot on top of the module.

® GREEN or BLUE = 900 MHz
® RED =433 MHz

Every now and then the paint dot shows up without a color or with the ink dot burnt. This is just a
manufacturing variance and there is nothing wrong with the board. You should get the frequency you
ordered though. So if you plan on mixing these up, you may want to add a new mark of your own.
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My radio has a burnt blob on it, is it damaged?

Nope! The radios have an ink dot on them, which sometimes gets toasty when we put the board
through the oven, or rework it, so it may have a burnt appearance. The chip is fine!
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Downloads

Datasheets & Files

FCC Test Report (https://adafru.it/oCO)

RoHS Test Report (https://adafru.it/oC1)

RoHS Test Report (https://adafru.it/oC2)

REACH Test Report (https://adafru.it/oC3)

RFEM69HCW datasheet - contains the SX1231 datasheet plus details about the
module (https://adafru.it/mCu)

® SX1231 Transceiver Datasheet (https://adafru.it/mCv)

® FagleCAD PCB Files on GitHub (https://adafru.it/obt)
® Fritzing object in Adafruit Fritzing Library (https://adafru.it/aP3)

https://adafru.it/zZ3E

https://adafru.it/z3E
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Fabrication Print

Dimensions in Inches
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https://cdn-shop.adafruit.com/product-files/3071/p3071p3077_RFM69HCW-433S2-FCC.pdf
https://cdn-shop.adafruit.com/product-files/3076/CAN14-015141-02_EC_15137200_F.PDF
https://cdn-shop.adafruit.com/product-files/3076/CAN15-031854-04_EC_15983075_F.PDF
https://cdn-shop.adafruit.com/product-files/3076/CAN15-031854-07_EC_15983075_F.PDF
https://cdn-shop.adafruit.com/product-files/3076/RFM69HCW-V1.1.pdf
https://cdn-shop.adafruit.com/product-files/3076/sx1231.pdf
https://github.com/adafruit/Adafruit-Feather-32u4-RFM-LoRa-PCB
https://github.com/adafruit/Fritzing-Library
https://cdn-learn.adafruit.com/assets/assets/000/046/202/original/feather_32u4_RFMxx_V1.3.pdf?1504806298
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